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Welcome to Mail 

In many businesses today, projects are completed by workgroups of individuals, 
each contributing a special skill. Consequently, the ability of workgroup members 
to communicate is an important factor in completing a project smoothly and on time. 

The Mail electronic mail system helps you communicate electronically and effi-
ciently with your coworkers. With Mail, you can: 

• Send and receive electronic messages. 

• Attach files created with other applications, such as spreadsheet and word-
processing applications, to your messages. 

• Find messages in your mailbox according to criteria you specify. 

• Print your messages. 

• Organize and store messages in folders. 

Overview of the Documentation 
The documentation for Mail consists of this User's Guide and online Help. 

This guide is divided into two parts. Part 1 provides an overview of Mail and 
teaches you how to use the basic features of Mail. All Mail users should read Part 
1. Part 2 explains how to manage a Workgroup Postoffice (WGPO). This part is 
written for the user in each workgroup who is planning to create and manage the 
WGPO. This person is referred to as the administrator. All the information you 
need to create and manage a WGPO is in this guide. 

Although this guide will get you started using Mail, your main source of infor-
mation is online Help. Help is stored on your hard disk when you install Mail. As 
you work with Mail and want to learn to use a specific feature, the information is 
just a keystroke away. You can get the information you need without tracking down 
a manual or interrupting someone for the procedures. 
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For a complete description of Help, see Chapter 1, "Overview of Mail and Online 
Help." 

Document Conventions 
This guide uses the following conventions. 

Convention 	 Used for 

bold 	 Anything that needs to be typed exactly as 
shown. 

italic 	 New terms or placeholders that represent 
information you must provide. 

monospace 	 Examples, Mail settings, and error messages. 

ALL CAPITALS 	 Filenames, directory names, and paths. 

SMALL CAPITALS 	 Names of keys on the keyboard. 

KEY+KEY 	 Key combinations where you must press and 
hold down the first key while pressing the 
second key. 

KEY, KEY 	 Key combinations where you must press and 
release the first key, and then press and 
release the second key. 
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PART 1 

Using Mail 

Part 1 provides an overview of Mail and teaches you how to use the basic features 
of Mail. All Mail users should read this part. 
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CHAPTER 

Overview of Mail and Online Help 

This chapter gives an overview of using Mail and online Help. 

Using Mail 
Mail is part of the set of applications included in Windows'' for Workgroups 
operating system. With Mail, you send and receive electronic messages and files. 

Before you can use Mail, someone in your workgroup needs to create a Workgroup 
Postoffice (WGPO). The WGPO contains all the information about Mail user 
accounts, and it serves as a collective mail drop facility for users in your 
workgroup. 

The person in your workgroup who creates and manages the WGPO is called the 
administrator. Part 2, "Managing the WGPO," explains how to create and manage 
a WGPO. 

Each Mail user in your workgroup has a message file where messages are stored. 
This message file is like a private mailbox. Each message file and the messages in 
it are protected by a password that only the user knows. 
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After you sign in to Mail (explained in Chapter 2, "Starting Mail"), Mail displays 
the Inbox, where your messages and folders appear. 

The Inbox displays Mail message headers. Each message header shows who sent 
the message, the subject, and the date and time the message was received in your 
mailbox. If the sender specified an urgent priority for the message, an exclamation 
point appears beside the message icon; a low-priority message appears with a down 
arrow. 

You can sort messages by priority, sender, subject, or date. 

You can store your messages in folders, which make messages easy to organize. If 
you want to keep a record of the messages you send to other people, you can 
automatically save copies of your messages in the Sent Mail folder. 
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When you read a message, it appears in a Read Note form. 

The gray area at the top of the form is the message heading. The message heading 
shows who sent the message, when it was received, who it was sent to, and the 
message subject. Using the tool bar or menus, you can reply to messages, forward 
them to other Mail users, print or delete them, or move or copy them to folders. 
Attached files appear in messages as icons. An attached file is a file containing any 
kind of data, including text, graphics, a spreadsheet, executable code, and so on. If 
you have the application that was used to create the file, you can open the file from 
the message by double-clicking it. 
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Creating a message is as easy as clicking the Compose button on the tool bar, which 
displays the Send Note form. 

o 	 Send Note 0 
Send 	Check Names 	Attach 	Options 	Address 

+ 
To: 

Cc: 

Subject: 

	 LI 

Sending electronic mail is easier than sending paper mail because you don't have to 
know the recipient's address or office number. Mail uses address lists to simplify 
message addressing. When you use your Address Book to address your message, 
you can see the names of other Mail users. 

Address 

Directory: Postoffice List 

Alessandro Pompei 
Andy MacKay 

,.,  
Bob Andrews 
Bonita Gonzalez 
Bruce Bergstrom 
Catherine Boll 
Connie Laine 
Design Group 
Gertrude Chorel 

~ 

FT. 

Add: To 	Cc 	a 	Details 

To: 

+ 

Cc: 

+ 

OK 	 Help 	J 
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Close 
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To easily find the names of people to whom you often send messages, you can copy 
their names from the Postoffice List into your own Personal Address Book. If you 
often send messages to the same group of people, you can create a personal group 
name for them. When you include that group name on a message's recipient list, all 
the individuals in the group receive the message. 

In the message body, you can cut and paste text between messages and files. If you 
want to send formatted files, such as Microsoft ()Word  or Microsoft Excel docu-
ments, you can send them with the message as attached files. With the Attach 
dialog box, you can send as many attachments as you like with each message. 

Using Help 
Mail provides online Help for each task you can perform. You can get Help for user 
tasks through the Contents on the Help menu or by searching for an entry in Help. 
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As you work with menus and dialog boxes, press Fl to get the Help Contents. To get 
Help about a menu command, display the menu by pressing ALT and the underlined 
letter in the menu name, then use the DOWN ARROW key to highlight the command 
name, and then press Fl. 

► To view the Table of Contents 

• From the Help menu, choose Contents. 

The following Table of Contents appears. 

File Edit Bookmark Help 

Contents 	 Back 
	

History 

Mail Help 

Contents 

O Getting Started with Mail 

O Sending Messages 
❑+ Using the Address Book 

❑+ Working with Messages You've Received 

❑+ Including Files and Objects in Messages 

❑+ Using Folders 
❑ Setting Mail Options 
❑ Working Offline 

E Managing Your Message File 
Reference 

E Keyboard Controls 

The topics describe the major categories of tasks you can perform with Mail. Topics 
with a plus sign (+) in their buttons contain subtopics. You can display the subtop-
ics by choosing the topic or the Expand button. Topics with plain buttons go 
directly to a Help topic. 

Note In this guide and in the procedures in Help, you are often instructed to 
"choose" a command or button. You can either click it with the mouse, or press TAB 

until the item is highlighted and then press ENTER to carry out the action. 
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❑ Reading a Message 

❑ Replying to a Message 

❑ Forwarding a Message 

❑ Printing a Message 

❑ Saving a Message as a Text File 

❑ Deleting and Retrieving a Message 

❑ Finding a Message 

❑ Moving Messages Between Folders 

Expand 
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The following example shows the results of choosing the Working with Messages 
You've Received topic. 
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The following example shows the Replying to a Message topic. 

You can reply to a message that's open or selected in the 
message list. 

To reply to a message 

1 Address your message in one of two ways: 

• To reply to only the sender, click the Reply 
button, or from the Mail menu, choose Reply 
(Alt, M, R). 

• To reply to the sender and everyone in the To 
and Cc boxes, click the Reply All button, or from 
the Mail menu, choose Reply To All (Alt, M, A). 

2 Type your reply. 

3 Click the Send button. 

Note The contents of the original message is included 
in the message body. You can add your own comments to 
the original, or you can delete the original contents. 

See Also 
Attaching a File 

Forwarding a Message 

Each topic describes how to perform a task so that you can quickly get the infor-
mation you need and return to work. 

If a term has a dashed underline, select it to display information about the term. 

Related topics, if any, are listed at the end of the procedure. You can jump directly 
to a related topic by choosing it. 

Note If you want to print a copy of a Help topic, display the topic and then choose 
Print Topic from the File menu. 

p To search for an entry in Help 

1. From the Help menu, choose Contents. 

The Table of Contents appears. 
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2. From the Help tool bar, choose the Search button. 

The Search dialog box appears. 

3. In the top box, type the word or phrase you want to find, or select one from the 
list. 

4. Choose the Show Topics button. 

In the bottom box, Help displays all the topics associated with the word you 
typed in the top box. 

5. From the list, select the topic you want to view. 

6. Choose the Go To button. 

Help displays the topic you selected. 
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CHAPTER 2 

Starting Mail 

This chapter explains how to start Mail for the first time, connect to a postoffice, 
sign in to Mail, change your password, and quit Mail. For information about setting 
up Windows for Workgroups, see Microsoft Windows for Workgroups Getting 
Started. 

Starting Mail for the First Time 
When you start Mail for the first time, you must do the following: 

• Create or connect to a postoffice. 

• Create an account for yourself in the postoffice if your administrator has not set 
up an account for you. 

If an existing Mail version 3.0 Postoffice has been assigned for your workgroup or 
someone in your workgroup has already created a Workgroup Postoffice (WGPO), 
you need to connect to that postoffice. If you need to create a new postoffice, see 
Chapter 5, "Creating a Workgroup Postoffice." 

If you have already connected to a postoffice and created your account, see 
"Signing In to Mail" later in this chapter. 

Connecting to a Postoffice 
Before connecting to a postoffice, ask your administrator for the path to the post-
office, and verify that your computer has enough available disk space for your 
message file (the MSMAIL.MMF file). The required disk space depends on the 
number and type of messages stored in your mailbox. A typical small mailbox 
requires about 100K of disk space; a large mailbox may require several megabytes 
of disk space. 
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To connect to a postoffice 

1. From the Main group in Program Manager, choose the Mail icon. 

The following dialog box appears. 

2. Select the Connect To An Existing Postoffice option button. 
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The following dialog box appears. 

3. Select the postoffice you want to connect to by doing one of the following: 

• In the Network Path box, type the path (\\computername\sharename) of the 
postoffice. 

• From the Show Shared Directories On box select the computer name for 
your postoffice. From the Shared Directories On \\computername box, select 
the shared directory for your postoffice. 

4. Choose the OK button. 

Mail displays a dialog box, asking if you have an account on this postoffice. 
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5. If you already have an account, choose Yes. You will be prompted for your 
password. 

If you need to create an account, choose No. 

The Enter Your Account Details dialog box appears. 

6. Create your account as explained in the following section. 

Creating Your Account 
Now that you have connected to a postoffice, you need to create an account. Before 
creating one, check that your administrator has not already created an account for 
you. 

► To create your account 

• In the Enter Your Account Details dialog box, fill in the appropriate 
information. 

Tip The Postoffice Manager does not distinguish between uppercase and lower-
case letters; "MARIAS," "MariaS," and "marias" are considered to be the 
same. When you fill in the Enter Your Account Details dialog box, type names 
that are easy to read. 

Required Information 

Box 	 Description 

Name 
	 Type your full name, for example, Maria Smith. The maximum 

length is 30 characters, and the default is the name you used when 
installing Windows for Workgroups. 

Mailbox 
	Type a unique name with which you will sign in to Mail. Choose a 

mailbox name that is easy to remember, for example, MARIAS. The 
maximum length is 10 characters, and the default is your Windows 
logon name. 

Password 
	

Type a password. You will use this password and your mailbox 
name to sign in to Mail. Choose a password that is easy to 
remember. The maximum length is 8 characters, and the default is 
PASS WORD. 
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Optional Information 

Box 	 Description 

Phone #1 	Type your phone number, for example, (206) 555-5555. The 
maximum length is 32 characters. 

Phone #2 	If you have two phone numbers or a phone number and a fax, type 
your second phone or fax number. The maximum length is 32 
characters. 

Office 	 Type your office location, for example, 5. The maximum length is 32 
characters. 

Department 	Type your department's name, for example, Sales. The maximum 
length is 32 characters. 

Notes 	 Type any comments about your account. The maximum length is 
128 characters. 

Once you have created your account, Mail displays the Inbox, where your messages 

and folders appear. 

Signing In to Mail 
When you create your account, you are signed in automatically. The next time you 
start Mail, you sign in by typing your mailbox name and password. You can set up 
Mail to enter your mailbox name and/or password automatically when you start it. 

► To sign in to Mail 

1. In the Main group in Program Manager, choose the Mail icon. 

Mail displays the Sign In dialog box. 

2. In the Name box, type your mailbox name and then press TAB. 

3. In the Password box, type your password and then press ENTER. 

Mail displays your Inbox. 

Each time you start Mail, you must type your mailbox name and password. Instead, 
you can have Mail enter your name and/or password automatically. 
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Important Record only your mailbox name and not your password, so others cannot 
read your messages and send messages under your name. 

► To sign in to Mail automatically 

1. In the Main group in Program Manager, choose the Mail icon. 

2. From the File menu, choose Properties. 

3. To have Mail automatically enter your mailbox name, at the end of the path in 
the Command Line box, type a space and then your mailbox name. 

For example: 

c:\msmail\msmail.exe marias 

—or— 

To have Mail automatically enter your mailbox name and password, at the end 
of the path, type a space, your mailbox name, another space, and then your 
password. 

For example: 

c:\msmail\msmail.exe marias secret 

Changing Your Password 
For security reasons, change your password regularly. If security is not a concern, 
you don't need to change it. If you forget your password, see Appendix A, 
"Troubleshooting." 

► To change your password 

1. From the Mail menu, choose Change Password (ALT, M, C). 

2. Type your old password, and then press TAB. 

For security reasons, you do not see the characters as you type them. 

3. Type your new password, and then press TAB. 

4. To verify the new password, type it again and then press ENTER. 

If your second attempt to type the new password does not match the first, the 
computer beeps; start over with a new password and then verify it. 

Your new password is registered. You'll be required to use it the next time you 
sign in to Mail. 
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Quitting Mail 
There are two commands on the File menu you can use to quit Mail: Exit and Exit 
And Sign Out. If Mail is the only application you are running that requires you to 
sign in to your mailbox, both of these commands close Mail and sign you out. 

If you are running another application that uses Mail to communicate with other 
members of your workgroup, such as Schedule+, the Exit command does not sign 
you out. This allows the other application to continue using the postoffice when 
Mail is closed. If you restart Mail, you don't need to sign in. 

The Exit And Sign Out command closes Mail and signs you out. If another applica-
tion that uses Mail is running, this command closes it also. If you restart Mail, you 
will need to sign in again. 

When you quit Mail, the default Mail setting permanently deletes all the messages 
in the Deleted Mail folder. If you don't want the messages in this folder deleted 
when you quit Mail, turn off this option with the Options command on the Mail 
menu. 

® To quit Mail and sign out 

• From the File menu, choose Exit And Sign Out (ALT, F, T). 

111 	To quit Mail and remain signed in 

• From the File menu, choose Exit (ALT, F, x). 

If other applications that use Mail are not running, the Exit command signs you out. 

The Message File 
After you connect to your postoffice and sign in, Mail creates an MSMAIL.MMF 
file on the directory where you installed Windows for Workgroups. This file is 
called your message file. It stores your messages, message folders, and Personal 
Address Book. The postoffice updates the file when it receives messages for you. If 
you have a problem with your message file, a message appears, giving you an 
option to repair this file. 
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CHAPTER 3 

Learning Mail 

This chapter covers the basic steps for sending messages and working with mes-
sages you've received. You should be able to complete all the procedures in 
approximately 20 minutes. Use this chapter if you want to practice: 

• Sending a message. 

• Reading a message. 

• Replying to a message. 

• Deleting a message. 

For this practice, you will send a message to yourself and then work with the same 
message. 

Some advanced features of Mail are described at the end of this chapter, and refer-
ences to information about using these features are provided. 
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Before You Begin 
Before you begin, you must start Mail and sign in. For information, see Chapter 2, 
"Starting Mail." 

When you see the Inbox, you're ready to begin. 

Pr:va,e Fuad,::, 

Inbox 
From 	 S.0jrct 	 Hecei---=_a 

d Deleted mail 
ir Inbox 
CD Sent mail 

..... 	.... 	
_ 	

__. __ ...................____ 

Sending a Message 
Sending a message involves a few simple steps: addressing it, typing a subject, 
typing the message, and sending it. 

Addressing a Message 
The first step in sending a message is to open a Send Note form and choose the 
users to whom you want to send the message. 

To address a message 

1. Click the Compose button, or from the Mail menu, choose Compose Note 
(ALT, M, N). 
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A Send Note form appears. 

o 	 Send Note 

Send Check Names 	Attach 	Options 	] 	Address 

Cc: 

To:  

Subject: 

	 ri- 

2. Choose the Address button (ALT+D). 

Note You can select a dialog box option by pressing ALT plus its underlined 
letter. 
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Mail displays the Address Book, which contains the names of users on your 
postoffice. 

Address 
Directory: Postoffice List 

Alessandro Pompei 
Andy MacKay 
Bob Andrews 
Bonita Gonzalez 
Bruce Bergstrom 
Catherine Boll 
Connie Laine 
Design Group 
Gertrude Chorel 

+ 

~ 
1 - 

Add: To 	Cc y Details 

To: 

Cc: 

+ 

+ 

+ 

OK 	J 	Cancel yelp ._J 

In this example, names are arranged alphabetically by first name, but this may 
differ from your address list. 

3. Type the first few characters of your name. 

The address list scrolls to the first name in the list with those characters and 
selects it. 

There are two other ways to locate user names in the address list. You can use 
the mouse to click the scroll arrows in the scroll bar, or you can press the arrow 
keys to scroll through the list. However, typing the first few characters of the 
user name is the fastest way to find a name. 

4. Press ENTER or choose the To button (ALT+T). 

Your user name is added to the To box. 

5. Press ENTER or choose the OK button. 
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You return to the Send Note form with your name entered in the To box. (In this 
chapter, "Barb Norton" will be used instead of your name.) If you select a name 
from the Address Book, the name is underlined in the Send Note form. The 
underline indicates that Mail verified the name in the postoffice. 

Note If your user name doesn't appear in the To box, repeat steps 3 through 5, 
making sure your name is selected before you press ENTER or choose the OK 
button. 

Typing a Message Subject 
The next thing you do is type the subject—a short description of the message. 

Because you're sending a test message, you can skip the Cc (courtesy copy) box. 

▪ 	To type a message subject 

1. Click the Subject box, or press TAB until the insertion point is in the Subject 
box. 

2. Type Test Message 

If you make a mistake while typing, press the BACKSPACE key to erase the error, 
and then continue typing. 

Typing a Message 
Mail provides a text editor for typing and editing messages. 

► To type a message 

1. Click anywhere in the message body, or press TAB. 

2. Type This is a test of the Mail system. I'm sending a simple message to 
myself for this test. 

If your text reaches the right margin of the form, the next word automatically 
moves to the next line; you don't need to press ENTER at the end of each line. 

Sending a Message 
The last step is to send the message. 

► To send a message 

• Choose the Send button (ALT+s). 
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The message disappears. In a few moments, a beep will alert you that you have 
received a new message. The message header appears in your Inbox. 

Reading a Message 
The message header in your Inbox displays information about the message, includ-
ing who the message is from and the date and time it was received. 

Private Folders 
Inbox _., 

From 	 I 	Subject Received 

M Deleted mail 
Inbox 

ILI Sent mail 

IR To: Barb Norton 	Test Message 2/5/92 2:01PM 

Because you haven't read the new message, Mail displays a closed-envelope sym-
bol and shows the sender's name in bold. 

To read the message 

• Double-click the message, or press TAB to move the highlight from the Folders 
list to the message list; use the arrow keys to highlight the message; and then 
press ENTER. 

The message appears in a Read Note form. 

From: 	Barb Norton 
Date: 	Wed, Feb 5, 1992 2:01PM 
To: 	Barb Norton 
Cc: 
Subject: Test Message 

This is a test of the Mail system. I'm sending a simple message to myself for 
this test. 



From: Barb Norton 
To: Barb Norton 
Subject: Test Message 
Date: Wednesday, February 5, 1992 2:01 PM 

This is a test of the Mail system. I'm sending a simple message to myself for 
this test. 
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Notice that the message heading of the Read Note form shows that the message 
is from your name and to your name. All messages you send and receive show 
who sent the message and who received it. 

Replying to a Message 
After reading a message, you may want to send a reply. The Reply button or com-
mand automatically addresses the message to the person who sent it and includes 
the original message in the message body. Including the original message is useful 
because you can add your comments above or within the original message. 

The following procedure shows you how to reply to and edit the original message. 

► To reply to a message 

1. Click the Reply button, or from the Mail menu, choose Reply (ALT, M, R). 

A Send Note form appears. The name of the original message sender appears in 
the To box, and the title of the original message appears in the Subject box, pre-
ceded by the prefix RE: (for "reply"). The original message is included in the 
form, below the solid line. 

2. Type See my comments below. 

3. Use the arrow keys to move the insertion point to the end of the original 
message. 
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4. Press ENTER to start a new line after the original message and type [Excellent 
idea!!] 

o 	 RE: Test Message  

Send 	Check Names 	Attach 	Options 	Address 

To: 

Cc: 

Barb Norton 

i 

Subject: RE: Test Message 

See my comments below. 

February 5, 1992 2:01 PM 

Mail system. I'm sending a simple message to myself for 

From: Barb Norton 
To: Barb Norton 
Subject: Test Message 
Date: Wednesday, 

This is a test of the 
this test. 
[Excellent idea!!] 

5. Choose the Send button (AL,T+s). 

Because you are replying to a message from yourself, you'll hear a beep in a 
few moments and see the reply in your Inbox. 

Deleting a Message 
To manage the number of messages you keep in your Inbox, you should delete 
messages you've already read and no longer need. 

► To delete a message from the Inbox 

1. In the Inbox, select the second Test Message. 

To select the Test Message, click it, or press TAB to move the highlight to the 
message list and use the arrow keys to highlight it. 

2. Click the Delete button, or choose Delete (ALT, F, D) from the File menu. 

The message is moved to the Deleted Mail folder, where you can retrieve it until 
it is deleted there. By default, Mail deletes messages in the Deleted Mail folder 
when you quit Mail. To change this option, choose Options from the Mail menu. 
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Advanced Features of Mail 
Mail has some advanced features that are fully described in Help. This section 
familiarizes you with these features and directs you to specific Help topics. 

To view a Help topic, choose Contents from the Help menu. 

Note If a Help topic is a subtopic, the main topic is listed first, followed by the 
subtopic. For example, "Creating a Folder or Subfolder" is part of "Using Folders," 
so the Help topic is listed here as: 

Help Topic Using Folders: Creating a Folder or Subfolder 

In the Help Table of Contents, you click Using Folders to show its list of subtopics, 
and then click Creating a Folder or Subfolder to view the procedure. 

Attaching Files 
Mail makes it easy for you to send one or more files with your message. You can 
attach application files, such as Microsoft Word or Microsoft Excel documents. 
You can also attach batch files, programs, graphics files, or any other files that are 
available to you. To avoid introducing a computer virus, you should use the same 
care when opening an attached file that you do when running a file from the net-
work or a floppy disk. 

Help Topic Including Files and Objects in Messages: Attaching a File 

Creating Message Templates 
If you send a specific message on a regular basis, such as a weekly progress report, 
you can set up a Send Note template for the message and preaddress it. When you 
need to send the message, you display the Send Note template, choose the Forward 
button, fill in the blanks, and send it. You don't have to spend time addressing the 
message or re-creating the form. 

Help Topic Sending Messages: Creating and Using a Message Template 
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Working with Embedded Objects 
Mail includes object linking and embedding capability. This allows you to copy 
parts of formatted documents from other applications, such as spreadsheets and 
word processing, into your messages without losing formatting. 

To avoid introducing a computer virus, you should use the same care when opening 
or activating an object in a message that you do when opening or activating an 
object from the network or a floppy disk. 

Help Topic Including Files and Objects in Messages: Embedding an Object in a 
Message; Working with an Embedded Object 

Finding Messages 
You can use the Message Finder command to search for messages you've stored in 
Mail folders. You can also keep multiple Message Finder windows minimized on 
the Mail workspace, each with its own search criteria. Then, when you want to 
search for a message with that criteria, you simply maximize the icon. 

Help Topic Working with Messages You've Received: Finding a Message 

Using Folders 
Mail stores your private messages in folders on your hard disk. Shared folders are 
stored in your postoffice and can be accessed by other users in your postoffice. 

Help Topic Using Folders 

Working Offline 
You may want to create new messages or work with messages you've received 
without being connected to the postoffice (for example, while you are traveling or 
working at home). If you have Windows for Workgroups and Mail installed on your 
computer, you can compose and work with messages without being connected to the 
postoffice. This is called working offline. 

When you connect to the postoffice after working offline, you can send the mes-
sages you've composed and save the messages you've worked with in your 
mailbox. 

Help Topic Working Offline 



PART 2 

Managing the Workgroup 
Postoffice 

Part 2 explains how to create and manage a Workgroup Postoffice. The user in each 
workgroup who will manage the Workgroup Postoffice should read this part. 
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CHAPTER 4 

Mail Administration Concepts 

Part 2 of this manual is written for the person creating and managing the Work-
group Postoffice. This chapter explains the concepts of Mail administration in a 
Windows for Workgroups system. 

The Role of the Administrator 
Before users in your workgroup can use Mail, they need to connect to a postoffice. 
If your workgroup does not have an existing postoffice, someone in your workgroup 
needs to create and manage a Workgroup Postoffice (WGPO). This person is called 
the administrator. 

Mail provides a graphical user interface, the Postoffice Manager, to manage the 
WGPO. Chapter 5, "Creating a Workgroup Postoffice," describes how to create a 
WGPO, and Chapter 6, "Managing Your Workgroup Postoffice," explains how to 
manage your WGPO. 

Using the Postoffice Manager, you can: 

• Add users to the WGPO. 

• Modify existing user accounts. 

• Remove users from the WGPO. 

• Manage the disk space where the WGPO is stored. 
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You may also need to perform one or more of the following tasks: 

• Change the name of your WGPO. 

• Move your WGPO. 

• Remove your WGPO. 

• Manage the Mail system files. 

The Mail Messaging System 
The Windows for Workgroups messaging system consists of the following: 

• The Mail application 

• The WGPO 

The Mail application runs on each user's computer, and the WGPO is stored in a 
shared directory on a computer that is running Windows for Workgroups. 

If your company already has a messaging system, you can use the Mail application 
with the postoffice or messaging (mail) server that is part of that system. To use 
Mail with an existing messaging system, see Appendix C, "Using Mail with Other 
Messaging Systems." 

The Workgroup Postoffice 
The WGPO contains all the information about Mail user accounts and serves as a 
collective mail-drop facility for users in your workgroup. To communicate, users 
must be connected to the same postoffice and have an account on that postoffice. 

The following figure shows three users in a workgroup with a WGPO. Maria 
Smith, Peter Black, and Isabelle Johnson belong to a workgroup called Engineering. 
To allow users in the Engineering workgroup to use Mail, Maria created a WGPO 
on her computer and accounts for herself, Peter, and Isabelle. Because she 
created the WGPO, she will be its administrator. Maria, Peter, and Isabelle use 



Maria Smith 
Ana Freeman 

Eng-Mktg Workgroup 

Because there are two postoffices in this 
workgroup, Sam and Ana cannot communicate 

with Maria, Peter, and Isabelle. 

Peter Black Sam White 
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their respective computers to run Mail, and their message files are stored on their 
computers as well. They can now use Mail to send messages and files to each other. 

Engineering Workgroup 

Maria Smith 

	

	 Isabelle Johnson 

Peter Black 

Two users connected to different WGPOs cannot exchange messages. The fol-
lowing figure shows a new workgroup that includes the original Engineering work-
group and two new users from Marketing, Sam and Ana. Sam created another 
WGPO on his computer, and he created accounts for himself and Ana. In this 
configuration, Maria, Peter, and Isabelle can communicate with each other. Simi-
larly, Sam and Ana can communicate. However, Sam and Ana cannot communicate 
with Maria, Peter, and Isabelle because they are not connected to the same 
postoffice. If Sam deletes his postoffice and Maria creates accounts for Sam and 
Ana on her postoffice, all five can communicate with each other. 

Isabelle Johnson 



Maria Smith 

Peter Black 	Isabelle Johnson 
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In addition to creating a WGPO on a computer that is part of your workgroup, you 
can create it on a file server that is part of an existing network, such as a Novell 
NetWare or a Microsoft LAN Manager server. For information about this configu-
ration, see Appendix B, "Using Mail with Other Networks." 

The following figure shows the Engineering workgroup connected to a postoffice 
that is part of an existing messaging system. For this configuration, the administra-
tor of the existing messaging system is responsible for setting up and configuring 
the postoffice. Each member in the Engineering workgroup needs to connect to that 
postoffice, as explained in Chapter 2, "Starting Mail." 

Engineering Workgroup 
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CHAPTER 5 

Creating a Workgroup Postoffice 

This chapter explains how to create a Workgroup Postoffice (WGPO). The person 
who creates the WGPO should plan to manage it. 

Creating the WGPO requires that you: 

• Verify that there is enough disk space on the computer where you will install it. 

• Create the WGPO and an account for the administrator. 

• Share the WGPO so that all users in your workgroup can use it. 

Chapter 6, "Managing Your Workgroup Postoffice," explains how you manage the 
WGPO you have created. 

Verifying Disk Space 
Before creating your WGPO, verify that your computer meets the following 
requirements. 

On the computer where the WGPO will be installed: 

• 360K of available disk space for an empty postoffice. 

• 16K of available disk space for each user account. 

On each user's computer: 

• Enough available disk space for each user's mailbox. 

The required disk space depends on the number and type of messages stored in a 
mailbox. A typical small mailbox requires about 100K of disk space; a large 
mailbox can take up several megabytes of disk space. 



— Postoffice Selection 

0 Connect to an existing postoffice 

0 Create a new Workgroup Postoffice 

Welcome to Mail 

Before you can use Mail, you must either 
connect to an existing postoffice or create 
a new Workgroup Postoff ice. 

OK Cancel 
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Creating the Postoffice and the Administrator Account 
After you have verified that the computer has enough disk space to create a WGPO, 
you can create your WGPO and administrator account. The administrator account is 
the first account you create in the WGPO. 

Important The computer where you create your WGPO must be turned on at all 
times so that users can exchange mail. 

If you want to create the WGPO on a network server, see Appendix B, "Using Mail 
with Other Networks," for specific instructions. 

You should create only one WGPO per workgroup. Only the users connected to the 
same WGPO can communicate with each other. 

After you create the administrator account, you can modify it, but you cannot 
remove it. 

To create a WGPO and the administrator account 

1. Start Mail. 

Mail starts the Postoffice Manager by displaying the following dialog box. 

2. Select the Create A New Workgroup Postoffice option button. 



Y 

Mail 

There should be only one Workgroup Postoffice 
within a workgroup. If a postoffice already 
exists, you should connect to that postoffice 
instead of creating a new one. 

If you create a new postoffice, you will be 
responsible for managing it. 

Do you want to create a postoffice? 

Create Workgroup Postoffice 

Create WGPO in: 
c:\windows 

( 	c:\ 
windows 

Drives: 

OK 

  

Cancel 

 

  

Network 

 

  

c: maria 
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3. Choose the OK button. 

The following dialog box appears. 

4. Choose the Yes button. 

The following dialog box appears. 



Enter Your Administrator AccounDetails 

Name: 	Maria Smith 

Mailbox: 	MARIAS 

Password: secret 

Phone #1: 	(206) 555-5555 

Phone #2: 

Office: 	5 

Department: Sales 

  

Notes: 

   

OK 

 

Cancel 
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5. Select a location for your WGPO. 

You can create the WGPO either on your hard drive or on a network server. 

• To create the WGPO on your hard drive, select a drive from the Drives box 
and a directory from the Create WGPO In list. 

—or— 

■ To create the WGPO on a network server, choose the Network button, and 
select a server and shared directory from the dialog box. 

6. Choose the OK button. 

The following dialog box appears. 

Use this dialog box to create the administrator account. In this box, fill in the 
appropriate information. 

The Postoffice Manager does not distinguish between uppercase and lowercase 
letters; "MARIAS," "MariaS," and "marias" are considered to be the same. 
When you fill in this dialog box, type names that are easy to read. You can use 
extended characters (such as letters with accents), but it is not recommended. 
Only alphanumeric characters are allowed in the Mailbox and Password boxes. 
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Required Information 

Box 	 Description 

Name 
	

Type your full name—in this example, Maria Smith. The maximum 
length is 30 characters, and the default is the name you used when 
installing Windows for Workgroups. 

Mailbox 
	

Type a unique name with which you will sign in to Mail. Choose a 
mailbox name that is easy to remember—in this example, 
MARIAS. The maximum length is 10 characters, and the default is 
your Windows logon name. 

Password 
	

Type a password. You will use this password and your mailbox 
name to sign in to Mail. Choose a password that is easy to 
remember. The maximum length is 8 characters, and the default is 
PASSWORD. 

Optional Information 

Box 	 Description 

Phone #1 	Type your phone number—in this example, (206) 555-5555. The 
maximum length is 32 characters. 

Phone #2 	If you have two extensions or one extension and a fax number, type 
the number for your second extension or your fax number. The 
maximum length is 32 characters. 

Office 	 Type your office location—in this example, 5. The maximum length 
is 32 characters. 

Department 	Type your department's name. The maximum length is 32 
characters. 

Notes 	 Type any comments about your account. The maximum length is 
128 characters. 



OK 

Mail 

Workgroup Postoffice created in 
C:\WINDOWS\WGPO 

e To allow other users in your workgroup to access 
the Workgroup Postoffice you just created, you 
must share the above directory. This can be done 
from the File Manager. Be sure to allow full 
access to the shared directory. You can assign a 
password if you want. 
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7. Choose the OK button. 

A dialog box telling you to share the WGPO directory appears. 

8. Choose the OK button. 

Sharing the Workgroup Postoffice 
After you create your WGPO, you must share the WGPO directory that contains 
the data files with all users on the postoffice. 

► To share your Workgroup Postoffice 

1. Open the File Manager and select the WGPO directory. 

2. From the Disk menu, choose Share As. 

3. In the Share Name box, type a name for your postoffice. The default is WGPO. 

4. Select the Re-share At Startup check box. 

5. Under Access Type, select the Full Access option button. 

6. Under Passwords, type a full access password for your WGPO (optional). 

7. Choose the OK button. 

Note After you create your WGPO, the Postoffice Manager command appears on 
the Mail menu when you start Mail. This command appears only on the computer 
where you created your WGPO. If you want to run the Postoffice Manager from 
another computer in your workgroup, you must modify your MSMAIL.INI file as 
explained in Chapter 6, "Managing Your Workgroup Postoffice." 
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CHAPTER 6 

Managing Your Workgroup 
Postoffice 

After you have created your Workgroup Postoffice (WGPO) and your administrator 
account, you manage the WGPO with the Postoffice Manager. 

Important Only the administrator can run the Postoffice Manager. The adminis-
trator can manage the WGPO from any computer that is part of his or her work-
group. For instructions, see "Workgroup Postoffice Installation Results" later in 
this chapter. 

With the Postoffice Manager, you can: 

• Add users to the WGPO. 

• Modify existing user accounts. 

• Remove users from the WGPO. 

• Manage the disk space where the WGPO is stored. 

You may also need to perform one or more of the following tasks: 

• Change the name of your WGPO. 

• Move your WGPO. 

• Remove your WGPO. 

• Manage the Mail system files. 
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Starting the Postoffice Manager 
Before you can start the Postoffice Manager, you must start Mail (see Chapter 2, 
"Starting Mail"). 

► To start the Postoffice Manager 

• From the Mail menu, choose Postoffice Manager. 

Mail 	Window 	Help 

Compose Note CtrI+N 

Address Book... 
Personal Groups... 

Options... 

Change Password... 
Backup... 

Postoff ice 'Man 	er... 

The following dialog box appears. 

    

Postoffice Manager 

                

                    

  

Users on C:\WINDOWS\WGPO: 

                 

  

Maria Smith 

       

Details... 

    

          

Add User... 

    

                      

                      

          

Shared Folders,., 

   

                      

             

QIose 
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With this dialog box, you can add users, modify user accounts, and remove 
users. 

Adding a User 
To add a user to your WGPO, you must provide the user's name, mailbox name, 
and password. 

Optionally, you can also provide the user's phone number(s), office location, and 
department, and comments about the user's account. 

Important Users who do not have an account on the WGPO can each create their 
own account. If you create the account, be sure to give the account information to 
the user. 

To add a user 

1. From the Postoffice Manager dialog box, choose the Add User button. 

The following dialog box appears. 

_ Add User 

Name: 	Peter Black 

Mailbox: 	peterb 

Password: peter 

Phone #1: 555-5555 

Phone #2: 

Office: 	3 

Department: Engineering 

Notes: 

OK 
	

Cancel 
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2. Fill in the appropriate information. 

For a complete description of these entries, see Chapter 5, "Creating a Work-
group Postoffice." 

3. Choose the OK button. 

Modifying a User Account 
With the Postoffice Manager, you can modify any information about the user's 
account. 

0 To modify a user account 

1. From the Postoffice Manager dialog box, select the user name you want to 
modify. 

1I 	 Postoffice Manager 

Users on C:IWINDOWSiWGPO: 	~ 

Details... Maria Smith 
Peter Black  

Add User... 

ri—tern 	User,. 

[—Shared Folders.,.} 

close 



Peter Black 

Name: 	Peter Black 

Mailbox: 	peterb 

Password: ****** 

Phone #1: 	555-5555 

Phone #2: 

Office: 	3 

Department: Engineering 

Notes: 

OK [Cancel 
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2. Choose the Details button. 

A dialog box with the user's account information appears. 

3. Change the appropriate entries. 

4. Choose the OK button. 



Are you sure you want to remove the user Peter 
Black? 
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Removing a User 
With the Postoffice Manager, you can remove a user from your WGPO. 

Note You cannot remove the administrator's account. 

► To remove a user 

1. From the Postoffice Manager dialog box, select the user name you want to 
remove. 

Postoffice Manager 

Users on C:\WINDOWS\WGPO: 

Details... Maria Smith 
Peter Black 

Add User... 

Remove User 

Shared Folders... 

döse 

2. Choose the Remove User button. 

The following dialog box appears. 

3. Choose the Yes button. 
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Managing Disk Space 
Managing the disk space where the WGPO is stored is one of the most important 
administrative tasks. To manage disk space, you need to check the current status of 
shared folders and recover unused disk space by compressing shared folders. 

A shared folder is a public folder that is stored in the WGPO, unlike users' private 
folders, which are stored on their own computers. All users in your workgroup can 
open shared folders and see the messages they contain. Any user in the WGPO can 
create a shared folder and choose the appropriate access permissions (Read, Write, 
or Delete). 

Checking the Status of Shared Folders 
By checking the status of shared folders, you determine: 

• The number of shared folders. 

• The number of messages stored in shared folders. 

• The amount of disk space the messages use. 

• The amount of disk space you can recover by compressing shared folders. 

► To check the status of shared folders 

• From the Postoffice Manager dialog box, choose the Shared Folders button. 

The Shared Folders dialog box shows the current status of shared folders in your 
WGPO. 

 

Shared Folders 

     

 

—Current Status of Shared Folders 

      

       

 

Number of folders: 12 

Total messages in folders: 183 

Bytes used by messages: 267,320 

Recoverable bytes in folders: 34,768 

     

   

Close 
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Compressing Shared Folders 
Compressing shared folders recovers disk space. When the Mail system runs out of 
disk space, this is the first step to take. If you still require more space, you can 
delete old messages and unused folders. You may need to move the WGPO to a 
different location (see "Moving Your Workgroup Postoffice" later in this chapter.) 

If your shared folders contain a large number of messages, the compression process 
may take a long time. 

► To compress shared folders 

1. From the Postoffice Manager dialog box, choose the Shared Folders button. 

The Shared Folders dialog box appears. 

2. Choose the Compress button. 

3. Choose the Close button. 

Important Do not attempt to compress shared folders while others are using them. 
Before compressing a shared folder, ask all users in your workgroup to close them. 

Changing the Name of Your Workgroup Postoffice 
You may need to change the name of your WGPO. For example, if you are part of a 
large company where someone else created a WGPO with the same name as yours, 
either you or the administrator of the other WGPO needs to change the name of the 
WGPO. 

Before you rename your WGPO, inform users in your workgroup that they will not 
be able to exchange messages until they reconnect to the renamed WGPO. 

► To rename your Workgroup Postoffice 

I. Ask all users in your workgroup to exit and sign out of Mail. 

2. Open the File Manager and select the WGPO directory. 

3. From the Disk menu, choose Share As. 

4. In the Share Name box, type the new name for your WGPO. 

5. Choose the OK button. 
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6. Edit the following line in the [Microsoft Mail] section of your MSMAIL.INI file 
to reflect the new name of the WGPO: 

ServerPath=drive:\directory 

—or— 

ServerPath=\\computername\sharename 

If your shared directory had a password, you need to delete or edit the line 
specifying the password for the shared directory. 

7. Inform users in your workgroup of the new name, and ask them to edit the 
following line in the [Microsoft Mail] section of their MSMAIL.INI file to 
reflect the new name of the WGPO: 

ServerPath=\\computername\sharename 

They may also need to delete or edit a line specifying a password for the shared 
directory. 

Moving Your Workgroup Postoffice 
You may need to move your WGPO to a different location—for example, if the 
computer where you installed the WGPO runs out of disk space. 

Before you move your WGPO, inform users in your workgroup that they will not be 
able to exchange messages until they reconnect to the relocated postoffice. 

▪ To move your WGPO 

1. Ask all users in your workgroup to exit and sign out of Mail. 

2. Open the File Manager and select the WGPO directory. 

3. From the File menu, choose Move. 

4. In the To box, type the new path for your WGPO. 

5. Choose the OK button. 

6. Share your WGPO as explained in "Sharing the Workgroup Postoffice," in 
Chapter 5, "Creating a Workgroup Postoffice." 

7. Edit the following line in the [Microsoft Mail] section of your MSMAIL.INI file 
to reflect the new location of the WGPO: 

ServerPath=drive:\directory 

—or— 

ServerPath=\\computername\sharename 

If your shared directory had a password, you need to delete or edit the line 
specifying the password for the shared directory. 
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8. Inform users in your workgroup of the new location for the WGPO, and ask 
them to edit the following line in the [Microsoft Mail] section of their 
MSMAIL.INI file to reflect the new location of the WGPO: 

ServerPath=\\computername\sharename 

They may also need to delete or edit a line specifying a password for the shared 
directory. 

Removing Your Workgroup Postoffice 
You may need to remove a WGPO that you just created, for example, if something 
goes wrong when you are creating it and you want to re-create it. 

Before you remove your WGPO, inform users in your workgroup that they will not 
be able to exchange messages until they reconnect to a new postoffice. 

To delete your WGPO 

1. Delete the WGPO directory tree. 

2. Delete the following lines from the [Custom Commands] section of your 
MSMAIL.INI file: 

WGP0Mgr1=3.0;Mai1;;13 

WGP0Mgr2=3.0;Mai1;&Postoffice Manager...;14; 

WGPOMGR.DLL;O;;Manage Workgroup Postoffice;MSMAIL.HLP;2870 

Managing the Mail System Files 
When you create a WGPO or users in your workgroup connect to a postoffice, the 
Mail system files are modified. The Mail system files are: 

• The message file, MSMAIL.MMF. 

• The Mail file, MSMAIL.INI. 

The message file, MSMAIL.MMF, stores messages, message folders, and the 
Personal Address Book for the user. The WGPO updates this file when it receives 
messages. The message file for each user is stored on his or her computer. Your 
message file is located in the directory where you installed Windows (the default is 
C:vWINDOWS). 

The Mail file, MSMAIL.INI, contains information that controls the way Mail 
works. Your MSMAIL.INI file is located in the C:\WINDOWS directory. 
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The Mail system files are automatically managed by Mail, so you shouldn't need to 
alter them unless you want to change specific functionality or you want to restore 
these files to a particular state. For example, if you install a WGPO and then you 
delete it, you need to modify your MSMAIL.INI file to connect to a postoffice. 

The following sections describe how these files are modified when you create a 
WGPO and when a user connects to a WGPO. They also describe how to back up 
and restore the Mail system files. 

Workgroup Postoffice Installation Results 
When you create a WGPO, the Postoffice Manager makes the following changes to 
the system files for the administrator account: 

• It creates the WGPO directory in the specified location. 

• It creates the following entries in the [Custom Commands] section of the 
MSMAIL.INI file: 

WGP0Mgr1=3.0;Mai1;;13 

WGP0Mgr2=3.0;Mai1;&Postoffice Manager...;14; 

WGPOMGR.DLL;O;;Manage Workgroup Postoffice;MSMAIL.HLP;2870 

These lines instruct Mail to display the Postoffice Manager command in the 
Mail menu when you start Mail on the computer where you created your 
WGPO. This command appears only on the computer from which you created 
your WGPO. If you want to run the Postoffice Manager on another computer, 
you must add these lines to the MSMAIL.INI file on that computer. 

• It adds the following lines to the [Microsoft Mail] section of the MSMAIL.INI 
file: 

ServerPath=drive:\directory 

Login—mailbox name 

• It creates a message file for the administrator account. The default name is 
MSMAIL.MMF. 
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Workgroup Postoffice Connection Results 
When users connect to a WGPO, the Postoffice Manager makes the following 
changes to their system files: 

• It creates the following entry in the [Microsoft Mail] section of the 
MSMAIL.INI file: 

ServerPath=\\computername\sharename 

Login=mail box name 

• It creates a message file for the user. The default name is MSMAIL.MMF. 

Backing Up and Restoring the Mail System Files 
When a user connects to a postoffice or creates a WGPO for the first time, Mail 
creates an MSMAIL.INI and an MSMAIL.MMF file (the Mail system files) for 
that user. After the Mail system files have been created, Mail automatically man-
ages them for each user. In general, you don't need to alter your Mail system files; 
however, you might want to restore them to a given state or alter them to change the 
way Mail works. 

It is a good practice to regularly back up your Mail system files. Then, if there is a 
problem, you can recover your mail and Mail environment from the last backup 
copy. The following procedures explain how to back up and restore your Mail 
system files. The procedures for backing up and restoring your MSMAIL.MMF file 
back up and restore all your folders in your mailbox. If you want to back up or 
restore only some of the folders in your mailbox, use the Export Folder and Import 
Folder commands. For information about using Export and Import, see the online 
Help. 

Important Before altering the MSMAIL.INI file, you should always make a backup 
copy in case you run into problems. After altering the MSMAIL.INI file, you must 
restart Mail for the changes to take effect. 

To back up your MSMAIL.MMF file 

1. From the Mail menu, choose Backup. 

2. In the File Name box, specify the name and location of your backup file, for 
example, C:\WINDOWS\MARIA.MMF. 

3. Choose the OK button. 
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► To restore your MSMAIL.MMF file 

1. Open the File Manager and select the backup copy of your message file. 

2. From the File menu, choose Rename. 

3. In the To box, type c:\windows\msmail.mmf 

4. Choose the OK button. 

The backup file becomes your message file, and your mailbox displays the mes-
sages and folders you had when you backed up the file. New messages that you 
received after you backed up your message file will not appear in your Inbox. 

► To back up your MSMAIL.INI file 

1. Open the File Manager and select your MSMAIL.INI file. 

Your MSMAIL.INI file is located in the directory where you installed Mail (the 
default is C:\WINDOWS.) 

2. From the File menu, choose Copy. 

3. In the To box, type a name for your backup file, for example, MSMAIL.OLD. 

4. Choose the OK button. 

To restore your MSMAIL.INI file, you can rename a backup copy, if you have one, 
or you can edit your existing MSMAIL.INI file. How you edit the file depends on 
whether you created a WGPO or connected to one. 

► To restore your MSMAIL.INI file after creating a WGPO 

If you made a backup copy of your MSMAIL.INI file, rename it to MSMAIL.INI, 
and move it to the directory where you installed Mail (the default is 
C:AWINDOWS). If you don't have a backup copy, follow these steps. 

1. Remove the following lines from the [Custom Commands] section of your 
MSMAIL.INI file: 

WGP0Mgr1=3.0;Mail;;13 

WGP0Mgr2=3.0;Mai1;&Postoffice Manager...;14; 

WGPOMGR.DLL;O;;Manage Workgroup Postoffice;MSMAIL.HLP;2870 

2. Remove the following lines from the [Microsoft Mail] section of the 
MSMAIL.INI file: 

ServerPath=drive:\directory 

Login—mailbox name 
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► To restore your MSMAIL.INI file after connecting to a WGPO 

• If you made a backup copy of your MSMAIL.INI file, rename it to 
MSMAIL.INI, and move it to the directory where you installed Mail (the default 
is C:AWINDOWS). 

—Or— 

• If you don't have a backup copy, remove the following lines from the [Microsoft 
Mail] section of your MSMAIL.INI file: 

ServerPath=\\computername\s ha rename 

Login=mai1box_name 
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Troubleshooting 

This appendix contains information to help you solve problems you may encounter 
when creating or managing the Workgroup Postoffice (WGPO). 

You Cannot Create a Workgroup Postoffice 
There are several reasons why you may not be able to create a WGPO. Most often, 
it is because you don't have enough disk space or, if you are creating the WGPO on 
a server, because you don't have write permission on that server. In this case, find a 
new location with enough disk space to create your WGPO. 

You Forget Your Password 
If you forget your password, you cannot recover it; you must create a new WGPO. 

A User in Your Workgroup Forgets His or Her Password 
If a user in your workgroup forgets his or her password, do the following: 

1. Sign in to Mail. 

2. Start the Postoffice Manager. 

3. In the Postoffice Manager dialog box, select the name of the user and choose the 
Details button. 

4. In the Password box, type a new password. 

5. Choose the OK button. 

6. In the Postoffice Manager dialog box, choose the Close button. 

Now the user can sign in to Mail with the new password. 
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A Message File Is Corrupted 
If a message file is corrupted, a message box appears, with an option to repair the 
message file. You or the user can either repair the file immediately or quit Mail and 
repair it later. However, the user with the corrupted file cannot use Mail until it is 
repaired. 



57 

APPENDIX B 

Using Mail with Other Networks 

In addition to creating a Workgroup Postoffice (WGPO) on a computer that is part 
of your workgroup, you can create it on a file server that is part of an existing 
network, such as a Novell NetWare or a Microsoft LAN Manager server. To add 
Macintosh, OS/2, and other mail users to your WGPO, see Appendix C, "Using 
Mail with Other Messaging Systems." 

This appendix describes how to set up a WGPO on another network. For more 
information about connecting your computer to another network, see Appendix B, 
"Using Windows for Workgroups with Other Networks," in the Microsoft Win-
dows for Workgroups User's Guide. 

Using Mail with a NetWare Network 
To use Mail with a Novell NetWare network, you need to create a WGPO on a 
NetWare server and grant full trustee rights to the WGPO directory. 

k. To create your WGPO on a NetWare server 

1. Create a directory on the NetWare server where the WGPO will be located. 

2. Grant full trustee rights to this directory. 

3. Use the Control Panel to set up NetWare support for your Windows for Work-
groups software. 

For instructions, see Appendix B, "Using Windows for Workgroups with Other 
Networks," in the Microsoft Windows for Workgroups User's Guide. 

4. Log on to your NetWare server. 

5. Start Windows for Workgroups. 
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6. Use the File Manager to map (assign) a drive letter to the NetWare directory 
where you want to create your WGPO. 

For instructions, see Appendix B, "Using Windows for Workgroups with Other 
Networks" in the Microsoft Windows for Workgroups User's Guide. 

7. Create your WGPO as explained in Chapter 5, "Creating a Workgroup 
Postoffice." 

Using Mail with a LAN Manager Network 
To use Mail with a Microsoft LAN Manager network, create a WGPO on a LAN 
Manager server and grant full access permissions to the WGPO directory. 

To create your WGPO on a Microsoft LAN Manager server 

1. Create a directory on the LAN Manager server where the WGPO will be 
located. 

2. Share the directory you just created. Make sure you don't share the parent 
directory. 

3. Provide full access permissions to the directory. 

4. Create your WGPO as explained in Chapter 5, "Creating a Workgroup 
Postoffice." 

For more information about LAN Manager, see the Microsoft LAN Manager 
Administrator's Guide. 

Mail works with a LAN Manager server automatically; you don't need to set up 
special support for it. However, to view the LAN Manager servers in the Connect 
and Share dialog box, there must be at least one computer in your workgroup whose 
workgroup name matches the name of the primary domain controller on the LAN 
Manager server. 

For information about setting LAN Manager options, see Appendix B, "Using 
Windows for Workgroups with Other Networks," in the Microsoft Windows for 
Workgroups User's Guide. 

Using Mail with Other Networks 
If you want to use Mail with another network, you need to set up support for that 
network in your Windows for Workgroups software, using the Control Panel. For 
information about the necessary Windows for Workgroups drivers and any further 
instructions, contact your network vendor. 
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APPENDIX C 

Using Mail with Other Messaging 
Systems 

The messaging system in a Windows for Workgroups environment consists of the 
Mail application and the Workgroup Postoffice (WGPO). However, if your com-
pany already has a messaging system with a mail server or postoffice, you can use 
the Mail application with the existing messaging system. 

To use Mail with an existing messaging system, you need to upgrade to a Mail 
version 3.0 Postoffice and add a gateway to the existing messaging system. The 
following table compares the messaging features of the WGPO with those of a Mail 
version 3.0 Postoffice. 

WGPO Mail version 3.0 postoffice 

Single postoffice mail features 

Single postoffice mail administration 

Basic security 

Support for Windows and MS-DOS 

Multiple postoffice mail features 

Multiple postoffice mail administration 

Advanced security 

Support for Windows, MS-DOS, Macintosh, 
and OS/2 version 1.3 

Ability to exchange mail with other messag-
ing systems through gateways 

Ability to exchange mail with Mail Remote 
version 3.0 Postoffices 

Ability to connect to a Mail version 3.0 Post-
office via a modem from a remote computer 

Advanced administration 

The following table tells you which Microsoft gateway to use for a given messaging 
system. 



60 	Appendix C Using Mail with Other Messaging Systems 

Messaging system 	 Microsoft Mail version 3.0 gateway 

ARCOM 400 Swiss PTT 	 X.400 

AT&T Mail 	 X.400 

Atlas 400 	 X.400 

Banyan Mail 	 MHS or X.400 

Beyond Mail 	 MHS 

cc:Mail 	 MHS, SNADS, or X.400 

The Coordinator 	 MHS 

CompuServe 	 SMTP or MHS 

Data General CEO 	 X.400 

DaVinci 	 MHS 

DEC All-In-1 	 X.400, PROFS, or SNADS 

DEC VMS Mail 	 X.400 or SNADS 

Dutch PTT 	 X.400 

EasyLink 	 X.400 

Envoy 100/Gemdes 	 X.400 

Fax 	 Fax 

Fischer International EMC2 	 X.400 or SNADS 

Gold 400 UK 	 X.400 

Higgins 	 MHS 

IBM AS/400 Office 	 SNADS 

IBM System36 	 PROFS 

IBM CMS NOTES 	 PROFS 

IBM DISOSS 	 SNADS 

IBM OfficeVision MVS 	 SNADS 

IBM PROFS 	 PROFS 

INFONET 	 X.400 

Internet 	 SMTP 

Lotus Notes 	 MHS 

Microsoft Mail for AppleTalk 	 Microsoft Mail connection 

NCR Cooperation 	 X.400 

Novell NetWare MHS 	 MHS 

(continued) 
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Messaging system 	 Microsoft Mail version 3.0 gateway 

Retix 	 X.400 

Soft-Switch Central 	 SNADS 

Sprint TeleMail 	 X.400 

Telebox 400 German PTT 	 X.400 

Touch 	 X.400 

Unisys 	 X.400 

UNIX SMTP 	 SMTP 

UUCP 	 SMTP 

Verimation Memo 	 SNADS 

Wang Office 	 MHS, X.400, or PROFS 

X.25 	 X.400 
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A 	 c 
Accounts 	 Case of letters (not case sensitive) 14, 38 

administrator account, creating 36-40 	 Cc box (courtesy copy) 21 
user account 	 cc:Mail 60 

creating (by administrator) 43-44 	 Characters 
creating (by user) 14-15 	 accepted by Postoffice Manager 38 
modifying 44-45 	 maximum length (for account details) 14-15, 39 
removing from WGPO 46 	 Choosing a command or button 6 

Address Book 	 Compose button 2, 20 
definition 4 	 Compose Note command 20 
displaying 21-22 	 Compressing shared folders 48 
Personal Address Book 5, 17 	 CompuServe 60 

Address button 21 	 Connecting 
Address list 	 to postoffice 11-14 

definition 4 	 working offline (without being connected to postoffice) 28 
locating names in (scrolling) 22 	 Conventions used in this manual viii 

Addressing messages 20-23 	 Coordinator (The) 60 
Administrator 	 Corrupted message file, repairing 56 

account 	 Creating 
creating 36-40 	 administrator account 36-40 
details 38-39 	 user account 14-15 

definition and role of 31-32 	 WGPO 
Advanced features of Mail 27-28 	 cannot create, troubleshooting 55 
ARCOM 400 Swiss PTT 60 	 procedure 36-40 
AT&T Mail 60 
Atlas 400 60 
Attached files 

as icon in message 3 	 Data General CEO 60 
illustration of dialog box 5 	 Date 2, 3 
overview 27 	 DaVinci 60 

DEC All-In-1 60 

B 	 DEC VMS Mail 60 
Deleted Mail folder 26 

Backing up Mail system files 52-53 	 Deleted message (.MMF) file, restoring from backup 52-53 
Banyan Mail 60 	 Deleting 
Beyond Mail 60 	 messages 26 

user from WGPO 46 
WGPO 50 
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Details 
administrator account 38-39 
user account 14-15, 45 

Disk space 
determining amount used by shared folders 47 
managing, overview 47 
recovering by compressing shared folders 48 
required for mailbox 35 
required for WGPO 35 

Documentation conventions viii 
Dutch PTT 60 

E 
EasyLink 60 
Editing and typing messages 23 
Embedded objects 28 
Envelope symbol 

closed 24 
illustration of 2 

Envoy 100/Gemdes 60 
Exclamation point in Inbox 2 
Exiting 

and signing out of Mail 17 
without signing out of Mail 17 

F 
Fl, pressing to get Help 6 
Fax 60 
File server, using Mail on network 57-58 
Files 

attachments 
as icon in message 3 
illustration of dialog box 5 
overview 27 

backing up and restoring 52-54 
message file 17 
repairing corrupted message (.MMF) file 56 

Finding messages 28 
Fischer International EMC2 60 
Folders 

backing up and restoring MSMAIL.MMF file 52-53 
checking status of shared folders 47 
compressing shared folders 48 
illustration of 2 
managing disk space on WGPO 47-48 
message folder 17 
overview 28 

G 
Gateways 59-61 
Gold 400 UK 60 
Group, personal 5 

H 
Hard drive See Disk space 
Headers See Message header 
Headings See Message heading 
Help 

advanced features of Mail (further described 
in Help) 27-28 

overview of Help 5 
printing Help topics 8 
searching for information 8-9 
Table of Contents, how to use 6 
topics, examples of 6-8 

Help menu, illustration of vii 
Higgins 60 

IBM AS/400 Office 60 
IBM CMS NOTES 60 
IBM DISOSS 60 
IBM OfficeVision MVS 60 
IBM PROFS 60 
IBM System36 60 
Inbox, description and illustration 2 
INFONET 60 
IN! file See MSMAIL.INI file 
Internet 60 

K 
Key combinations, conventions used in documentation viii 

L 
LAN Manager network 58 
List See Address list 
Logging in 15-16 
Logging out 17 
Lotus Notes 60 
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M 
Mail gateways 59-61 
Mail (program) 

See also Messages 
accounts See Accounts 
advanced features 27-28 
gateways 59-61 
Help (online) 5-9, 27-28 
overview of using Mail 1-5 
quitting/exiting 17 
signing in 15-16 
signing out 17 
starting for first time 11-15 
using on network 57-58 
using with WGPO 32-34 

Mail system files 
backing up 52-53 
changes made when installing or connecting 

to WGPO 51-52 
managing, overview 50-51 
repairing corrupted MSMAIL.MMF file 56 
restoring 52-54 

Mailbox 
definition 1 
name 

administrator account 38-39 
user account 14 

Manager See Administrator; Postoffice Manager (graphical 
user interface) 

Menu, illustration of 2 
Message file 

backing up and restoring 52-53 
corrupted, repairing 56 
description of 17 

Message Finder command 28 
Message folders 2, 17, 28 
Message header 2, 24 
Message heading 3 
Message subject 

illustration 2, 3 
typing 23 

Message templates 27 
Messages 

addressing 20-23 
deleting 26 
finding 28 
priority, display in Inbox 2  

Messages (continued) 
reading 24-25 
replying to 25-26 
sending 23-24 
stored in message (.MMF) file 17 
subject 2, 3, 22 
templates 23 
typing and editing 23 

Messaging system 
description of 32 
using Mail with other systems 59-61 

Microsoft Mail for AppleTalk 60 
Minus sign (in Inbox) 2 
.MMF file See MSMAIL.MMF file 
Moving the WGPO 49 
MSMAIL.INI file 

backing up and restoring 52-54 
description of 50-52 

MSMAIL.MMF file 
backing up and restoring 52-53 
description of 50-52 
repairing corrupted file 56 

N 
Names 

adding user to WGPO 43-44 
changing 

user account 44-45 
WGPO name 48-49 

maximum length 
administrator account 39 
user account 14-15 

removing user from WGPO 46 
NCR Cooperation 60 
Networks, using Mail on 57-58 
Novell NetWare MHS 60 
Novell NetWare network 57-59 

0 
Object linking and embedding 28 
Offline (working without a postoffice connection) 28 
Online Help See Help 

P 
Password 

administrator, creating 39 
changing 16 
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Password (continued) 	 Send Note form 
definition 1 	 filling in 20-23 
forgotten, troubleshooting 55 	 illustration of 4 
maximum length 14, 39 	 Sending messages 23-24 
user, creating 14 	 Server, using Mail on network 57-58 

Personal Address Book 	 Setting up 
definition 5 	 administrator account 36-40 
stored in message (.MMF) file 17 	 user account 14-15, 43-44 

Personal group 5 	 WGPO 36-40 
Plus sign 	 WGPO on a network 57-58 

in Help 6 	 Shared folders 
in lnbox 2 	 checking status of 47 

Postoffice 	 compressing 48 
See also WGPO (Workgroup Postoffice) 	 defined 47 
connecting to for first time 11-15 	 overview 28 
working without being connected (offline) 28 	 Signing in 15-16 

Postoffice administrator See Administrator 	 Signing out 17 
Postoffice Manager (graphical user interface) 	 Soft-Switch Central 61 

overview 41 	 Sprint TeleMail 61 
starting 42 	 Starting 

Printing Help topics 8 	 Mail for first time 11-15 
Priority messages, how displayed in Inbox 2 	 message 20-23 
Public folder See Shared folders 	 Postoffice Manager 42 

signing in 15-16 
Status 

Q details on user account 45 

Quitting Mail 17 	 of shared folders 47 
Subject of message 2, 3, 23 
System files 

backing up and restoring 52-54 
changes made during installation or connecting 51-52 

RE: (reply) 25 	 managing 50-51 
Reading messages 24-25 
Relocating the WGPO 49 
Removing 	 T 

user from WGPO 46 
WGPO 50 	 Telebox 400 German PTT 61 

Renaming the WGPO 48-49 	 Templates 27 

Repairing corrupted message (.MMF) file 56 	 Time 2 
Tool bar, illustration of 2 Replying to messages 25-26  

Restoring 	 Touch 61 

corrupted message (.MMF) file 56 	 Troubleshooting 55-56 

MSMAIL.MMF or MSMAIL.INI file 52-54 	 Typing messages 23 

Retix 61 

U 
S 
Searching for messages 28 
Send button 21, 23-24 

Unisys 61 
UNIX SMTP 61 
Urgent priority, how displayed in Inbox 2 



Index 	67 

User 
creating an account 14-15, 43-44 
details 45 
modifying an account 44-45 
names displayed in Address Book 22 
password, forgotten 55 
removing from WGPO 46 

UUCP 61 

V 
Verimation Memo 61 

W 
Wang Office 61 
WGPO (Workgroup Postoffice) 

adding a user 43-44 
backing up files 52-53 
compared to Mail version 3.0 Postoffice 59 
creating 

cannot create, troubleshooting 55 
on network file server 57-58 
procedure 36-40  

WGPO (Workgroup Postoffice) (continued) 
deleting 50 
disk space 

managing 47 
required 35 

folders, managing 47-48 
installing, effect on Mail system files 51-52 
managing, overview 41 
modifying a user account 44-45 
moving 49 
name, changing 48-49 
network, using on 57-58 
overview 32-34 
removing 50 
removing a user from 46 
restoring files 52-54 
sharing with other users 40 

Workgroup Postoffice See WGPO (Workgroup Postoffice) 
Working offline 28 

X 
X.25 61 
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